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Cue Player Premium

Created with the Standard Edition of HelpNDoc: Free PDF documentation generator
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Getting Started

Getting Started  Top Next

Cue Player Premium is a program to play theater sound cues. I needed to stop years of wrestling with
cassette players and reel-to-reel decks, or even CD players, to get cues on time - especially when actors
skip pages or transpose scenes! I thought it would be good to use the computer to help. Actually, that was
several years ago. Cue Player has been in constant use and incremental development for over 10 years with
now over 1000 licences around the world.

If you can get your cues into .wav, .ogg, .wma, .flac, .ac3, or .mp3 files, and there are many programs to do
this, plus the CDs of sound cues available, you can build a file of cues and their sounds with Cue Player
Premium. The program will present the normal sequence of cues and allow you to play them simply with a
mouse click or button push. You can also add music from the computer's CD player for pre and/or post
performance sound.

The video control option that shows up in the description of some of the menus and screens is an additional
cost to the base program. If you are a small theater, don't think that video is beyond your reach. Where I am
Technical Director (www.blackfriars.org), we use two consumer grade projectors to great effect. Imagine the
impact that actual falling snow, rain, or flowing water on the stage floor would have on your next production!
If you are interested in the possibilities and have questions, please drop me a note.

Created with the Standard Edition of HelpNDoc: iPhone web sites made easy

Contacting Us

Contacting Us Previous Top Next

Main Home page - www.baxeldata.com

E-mail - support@baxeldata.com
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What is Added? Previous Top Next

Cue Player Premium

What's been added over the free CuePlayer is this:

·     A 5 band graphic equalizer can be set for each cue.

·     A reverb setting is also available for each cue

·     The fade out duration is settable by cue

·     Auto Advance is settable by cue

·     Setting Auto Advance on a CD player based cue will move to the next track on the CD.

·     Cue file names can be added via drag and drop in the Cue Editor.

·     An Auto Play button, settable by cue, that sets the cue to immediately start playing when the cue is
selected, such as after an Auto Advance or a Fade timeout of the previous cue.

·     A cue can be one of two classes: normal or background. A background cue will continue to play after a
normal cue has been selected. This allows two sounds to play at once (think rainstorm with occasional
thunder) Since a fade-in time and a fade-out time for both cues can be set, cross-fading is possible.

·     The ability to play .ogg, .flac, .ac3, or .wma compressed files

·     The Master (Windows) volume control can be controlled independently of the cues.

·     A Pan control has been added to make it easier to slide cues from side to side.

·     The playing of a cue can be triggered by either Enter or Space (your choice) as well as mouse click.

·     The sound card or output device can be selected when the user has more than one installed.

What's been added over CuePlayerPro is this:

·     The cue text font is selectable.

·     Power (on/off) signals to an external controller can happen at cue start or stop. The web site has details
and links to power control suppliers. The 64 bit version replaced the Phidget controls with a more
general DMX cue ability.

·     Cue text color and cue background color are settable by cue.

·     An Auto Fade can be selected to fade the cue a settable number of seconds before its end.

·     Beyond stereo, if a 5.1 sound card is available, speaker selection is possible by cue.

·     Sound cues are now  all independent cues. As its name would indicate, an independent cue can play
anytime and several can play at once. 

·     A Function key can be assigned to play a cue. Doing so will make the cue independent and playing the
cue will not reposition your location in the cue list. The l and k keys can also be used as triggers as
required by some third-party key mappers.

·     A cue can be a volume change cue for a previously playing cue. Other actions include Pause, Resume,
Fade Out, Stop, and Wait for End.

·     The Master, or sound card, volume level can be set at Cue Player start to be either what it was when
you last used the program, or what is was when the last numbered cue was edited. In effect, either
computer specific or cue file specific.

introduction.html
introduction.html
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·     The starting position of a long cue can be set before or during playback. Useful in rehearsal when the
Director asks for “the last 30 seconds” of that music.

·     Auto Advance can be set for either the start or end of that cue. Allows several independent cues to start
at once.

·     A Black background selection is available

·     Cue file relocation is supported as well as building a cue file from a directory of sounds. Useful when
visiting troups bring their own sounds.

·     A playlist may be used as a sound file. This allows playing and looping a list of pre-show music as a
single cue.

·     The operating mode "Num-pad" allows you to play a sound by entering its line number and then Enter
from the num-pad. Useful at sporting events to play 'Jock-Jam' music for the game situation.

·     Start and Stop times of a sound can be set without going to an editor.

·     Time-line cues allow triggering of other sounds or actions based on progress of an already playing cue.

  

Created with the Standard Edition of HelpNDoc: Write eBooks for the Kindle

The Main screen

The Main Screen

 screen itself
Previous Top Next

The primary element of the Main screen is the cue list. The images demonstrate use of the "Smart Style"
and "Air 2" skins.

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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Here a description of every cue is displayed in a scrollable list. Cues may be selected via the mouse or the
up/down arrow keys. The current cue will be highlighted. The right side of each cue will show the special
characteristics of Auto-Play (green dot), Delay (yellow dot), Advance at Start (blue dot), or F-key if assigned.
If a cue is active and playing, the running time will display between the description and the dots.

Right click on the clock and the production timer menu will appear:

 You can select to start the timer, pause and resume it, or show either the timer or
the clock. When running and displayed, it takes the place of the clock.

 The timer can also be started and stopped as a special DMX cue. Details are
on the DMX Control topic

Cue List frame



Cue Player Premium Help

7 / 33

 holds the usual suspects of Add, Insert, Edit, and Delete. Add goes to the end of
the current list, Insert goes above the existing selected cue. Edit allows changes to the selected cue and
Delete deletes. Edit may also be invoked by right clicking the cue line. Copy and Paste make it easy to
duplicate a cue during the build process. The caption color will be the same as the clock's.

The large play button will start the cue, as will double-clicking the cue list line. Pressing the Enter key or
Space bar, as selected from the Options menu, will also start the selected cue line. 

  Pause will stop the currently highlighted and playing sound and Resume will start it where it
left off. All of these individual control buttons will only affect the highlighted/selected cue line. If an Advance
has moved the line from what is playing, then they have no effect.

 Stop will stop the currently selected and playing cue.

 Rewind puts you back to the start of the cue, including resetting the initial fade timing.

 The Fade button will fade out the playing cue per the value in the cue's "Fade at End" box.

Fade All and Stop All will work across anything playing. The Fade All duration is set
in the Menu Option "Set Cue Add Defaults".

 The slide controls  will set the volume level and can be either linked together or moved
separately to slide the sound from side to side. The green one is the Master volume. It is only effective for
the sound card Windows has registered. If you have installed an additional card and the cue is set to use
that card, the Master volume will have no effect. When the ALT key is pressed along with an up or down
arrow, the volume will be changed in that direction.

The Pan slide control  will also move the sound from side to side.
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 The Time display counts up or down (Options menu) as the cue plays. Hovering the mouse over
the slider icon in the time display will open the position selection slider. You can then change the current
playing position in the file. This works for both sound and video playback. Moving the mouse out will close it
and resume play at that time.

 In the lower right corner, the green dot is a CPU usage monitor. Hovering the mouse over it
will give the % usage. It will turn yellow at 51%, light red at 71%, and red at 86%. If light red or red, you may
experience stuttering on playback. You would want to check what other than Cue Player is running on the
computer.

  

Created with the Standard Edition of HelpNDoc: Free HTML Help documentation generator

File Menu

File Menu Previous Top Next

New Cue File - Creates a new blank cue file. You will be asked for the cue file name and at least the first
cue.

Open Cue File - Provides a file search window to select an existing  *.cue file.

Most Recent files - shows a drop-down of up to the last 8 used cue files.

Backup the Cue File - Allows saving the current cue file under a different name. You may save just the cue
file as is, or create a directory with all the sound and video files and an adjusted cue file. There is no plain
Save menu option as changes are saved automatically as you make them. Up to 3 automatically generated
backups are saved as additions and changes are made and when the program is closed. They have the
main cue file name and a date-time stamp appended.

Create Cue File from files - Allows selection of a directory and creates a cue file from the files contained

https://www.helpndoc.com
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in it. Useful to quickly build a cue file, the Edit screen will allow you to reorder them. After the files have
been selected, this window will allow choosing features of the resulting cue list:

Append a Cue File  - Allows adding a cue file to the end of the existing loaded file. Action cues in the
appended file will not be renumbered, so please edit your cue file after this action.

Create Playlist from Folder - Creates a playlist named "playlist.m3u" from a folder or directory of files.
That playlist can then be used as a sound file. Useful for pre/post show music.

Relocate Sound Files - Adjusts the entries of a cue file to the new location of its sound files. It will search
subdirectories for files.

Export Cue File to CSV - Creates a CSV file of the current cue file. That file can then be used by any
spreadsheet or database program for documentation or printing.

Export Cue File Descriptions - Creates a text file of the cue descriptions. That file can then be imported
by third party programs like Palladium.

Import Cue Player file - imports an existing Cue Player (free version) cue file into the Premium format.

Import Cue Player Pro file -  imports an existing Cue Player Pro cue file into the Premium format.

Import Cue Player pre 3.11 - imports an existing Cue Player Premium cue file in to the 3.11 format. I really
tried to avoid this, but the new video features required more fields.

Exit - close down the program.

  

Created with the Standard Edition of HelpNDoc: Free HTML Help documentation generator
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Set Defaults:
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  Global Fade ets the fade duration for the "Fade All" button. In
computers with more than one sound card, Cue Device allows selection of which device will be the default
for added cues. The output device is still selectable by individual cue. If the Cue Device is changed, the Set
Cues button will update all the cues in the current list. The default speakers for added cues can be set to
that of the first cue in the list. Also there are settings for the default cue type, initial volume, and display
colors. These are also still selectable by individual cue. Checking the Add Control cue will add an additional
control/action cue for each added cue. Auto Color cues will change the cue font color to gold for delay and
lime for auto-play cues as they are added or edited. The volume level of new cues may be set for less than
100% to allow headroom  The parameters for OSC (Open Sound Control) are the IP address and port
number of the receiving device, and the port number Cue Player will use to listen for commands. If you have
a Behringer X32 mixer, its IP address and port number will need to be set before 'Mixer Mute & Control' cues
will work. The contiguous channel range for the muted channels can be set. Details are in the OSC Control
topic. An additional option for external control is using DMX. Either a USB, using D2xx, or an ArtNet
compatible interface device may be used. They are the same as would be used for lighting control. Both
DMX King and Enttec Pro make excellent units.

Run Mode -  There are 6 modes. The Build mode shows all the cue line numbers and
the Cue List box. Build/Static disables the auto-advance and auto-play to make it easier to enter a large
batch of cues.  When Theatre is selected it removes the cue line numbers and Cue List box from the
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screen. It also disables right-clicking the cue list to edit. NumPad mode sets the Num Lock on the keyboard
and expects a line number to be entered from the Number Pad. The number pad Enter key will play the line
and the - (minus) key will fade it. This makes Cue Player great for sporting events where different 'Jock
Jams' are used as sound files. The two laptop modes expand the button sizes to make it easier to use on
touch screen computers. 

Set Skin - Allows selection of a skin or graphic appearance of Cue Player. Snow Leopard mimics Apple
software.

Change Clock Color - Allows selection of the color of the real time clock display. It also affects the running
time display of a playing cue.

Renumber Cue Calls -  Adds the Cue call either Sxx or Vxx to
sound and video cues.

Set "Play" Key - Allows selection of keyboard activation of a cue by either the Enter key or the Space bar.

Set Master Volume -  Master volume setting at startup can be either what it was when the program was
last closed or what it was when the last cue was edited.

Set Volume Curve -  Fades in and out will follow either a linear or logarithmic
curve. When using the linear curve, the volume range is from 0% (silent) to 100% (full). When using the
logarithmic curve, the volume range is from -100 dB (effectively silent) to 0 dB (full). For example, a volume
level of 50 is 50% linear or -50 dB logarithmic. Extended Fade is a linear fade, but for fades greater than 2
seconds, the fade is done a second shorter down to 10% of the original volume and then the final fade takes
1.5 seconds. This gives a more gentle fade out.

Set Background  - The Main screen background color can be either Light, Dark, or Black. Light allows
maximum use of cue line background and text colors. Black is traditional to avoid distracting light during a
show.

Set Cue Text Font - Allows selection of the cue list text font and font size.

Set MIDI Input Port - Sets the MIDI port for remote control of Cue Player. Available ports are automatically
discovered at program start and then listed. The MIDI Channel number is defaulted to 0, but can be changed
by editing the cueplayer.ini file entry for MidiChannel. A sub-menu will appear for selection of possible MIDI
devices.

Set MIDI Output Port - Sets the MIDI port for Cue Player to send output control signals.  A sub-menu will
appear for selection of possible MIDI devices.

Quick Cue Check - The current cue list will be checked one by one to see if the sound files exist where
they need to be.

Slow Cue Check - The current cue list will be checked one by one and 3 seconds of each will be played.

Reset Video position  - Restores the video player to the same screen as the main Cue Player. Allows
control of the player to be regained should it go offscreen to a inactive monitor.

Action Cue reminder - When selected, changes to a cue that has an action cue associated with it will
trigger a reminder window to check the cue number in that action cue.

Timer Counts Down  - When selected, the timer display of a playing cue counts down from the length of
the sound file toward 0. Otherwise, the time display counts up from 0.
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Auto Open Cue File - When selected, automatically opens the previous cue file at program start.
Otherwise, the cue list is blank at start.

Enable Keep Alive - When selected, activates the disk drive every minute so that it stays spinning. Still, it
is recommended that power control be turned off. That is, set the computer to be constantly on. It would
also be a good idea to turn off any virus checking program.You do not want a virus scan starting half way
through Act 1.

Auto increment Cue Call - When selected, automatically increments the number entered into the Cue Call
field.

Open Windows sound tool - this will give you direct access to the Windows sound tool:

Here you may have a finer control of output settings than within Cue Player. You may also set recording
devices, as shown, that will be helpful on setting up other tools. For example, ETC's Sound2Light program
input can be set to what Cue Player is playing, in this case, Stereo Mix.

Restore System sounds at Close -  by default, Cue Player turns off the system sounds at startup to avoid
any embarassing Windows sounds during use. This will restore them when Cue Player is closed.

Play Button Sync  - When running a second computer as a emergency backup during a show, the Play cue
commands of the first computer can be sent via OSC to the second. The latency is minimal. Details are in
the OSC Control topic. You may also use a TCP connection. The IP address of the Master computer will be
asked for when this is selected. Using TCP for the hot swap will free up the OSC ports for other use.

Enable Web Remote - When checked, the remote control server will be launched and minimize itself in the
lower left corner of the screen. Unchecking will remove it. Details on how to use the remote control are in the
"Remote Control" topic.

Enable Stream Deck - A third party button surface can be used with Cue Player. Details on the use and
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setup of it are in the "Stream Deck" topic.

Created with the Standard Edition of HelpNDoc: Free Qt Help documentation generator

The Edit screen

The Edit screen Previous Top Next

The window that appears has boxes where the cue description or prompt can be typed and where the
associated sound file is stored.

The Cue line entry is divided into two sections, the first of which does not clear when cues are added. The
intention is that entry is the stage manager's call for the cue e.g. "SQ2". The second part is the cue
description.

 Cue Type is normally Sound. The older 'Normal', and 'Background' types have been
discontinued. It can also be an OSC command, a local video, a remote or Slave computer video (allows
control of two projectors), or one of four network connected computers running the video player. If Midi
Output is selected, then the Sound File Name is actually a midi command, likewise for an OSC command.
Commands can also be sent via the network to a computer running Cue Player Lighting. This allows running
a show from one keyboard and operator. If using a Behringer X32 mixer, the active, unmuted, channels can
be set via a cue. Enter the channel numbers separated by a comma or a dash for a range. e.g. "2,5,7-
10,17". Channels 1 through 32 can be controlled. "None" will mute all those channels. Any of the OSC
messages can sent as well. e.g. "/ch/01/mix/fader ,f .5" will set the first fader to halfway. Multiple messages
can be joined by a ;. A DMX cue type has been added to allow sending DMX channels and values through
either a USB or ArtNet interface. The syntax for that type is xx@yy;aa@bb, where xx and aa are channels
(1 to 512) and yy and bb are levels (0 to 255).

Sound files may be typed in, drag and dropped from a file manager, or selected via the button.
If the sound file entry is just a number, then the cue is considered a volume or action cue for that number
cue. A value of 0 indicates a Delay cue for the duration in the Fade/Cross Time box. A Delay cue doesn't
play anything, just pauses the automatic advance for the specified time.
You may select a color for the text and the background (unless it is already black) of each cue.

The trigger for playing or running the cue can be either the Play key, as selected from the Options menu,
the time position of an already running cue, or a time of day. The number of a playing cue goes into the Cue
# field and the time position, in tenths of a second, goes into Time field. If the Cue # is 0 and the Time is
entered as hh:mm, the cue will play at that time. Hours greater than 12 are afternoon and evening, under 12

https://www.helpndoc.com
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for morning. For the cue you are editing to be triggered this way in use, it must be the current selected cue
in the cue list.

 The initial volume level can be set, as well as defining a cross-
fade to another volume level to happen automatically when the cue starts to play. You can fade-in or out as
you wish. The duration of the transition is the value in the Fade/Cross Time box in tenths of seconds. The
Same button will set the equalizer and reverb to the same settings as the previous cue. If the cue type is
Video, then the third slider will be colored purple and sets the brightness of the output after the Fade in time.
Between the sliders is a vu meter showing the volume levels when using the Test button to play the sound
file.

 To avoid having to edit a sound file to shorten it, or to set the exact
start and stop times of a loop, that timing can be set here. The time can be typed in or when the button
clicked, this screen appears:

The left mouse button or the cyan arrows will move the start time, The right mouse button or the yellow
arrows will move the end time. The Test button will play the file. If Loop is checked it will continue to play
while the times are adjusted. While playing, the Mark button will copy the current playing location to the
clipboard. You may then paste that time easily into a Time Line cue 'Time:' position. If 'Vamp' is checked,
the cue will play from 0 to the end time and then loop back to the start time. It will continue that loop until a
cue with the Action 'End Vamp' is played, at which time the loop end will deactivate and the file will play to
the end.

Start/Stop will also appear for Video cues. In that case, it looks like this:
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The cyan and yellow markers again define the start and stop positions. The bottom slider will change the
display to the time in the movie indicated under the picture. Please note that start times of a video,
especially a compressed one (e.g. .mp4), can vary from the selected cyan position due to the need to be at
a "key frame". Without going to deeply, computer videos are stored with key frames holding the entire image
and subsequent frames holding the differences from that key frame to the next. To start to play a video, it
must be from a key frame.

When you set an end time, Cue Player assumes you are finished playing the file at that time and goes to
black. If you want to go to the end and maintain the image, set the initial play cue to Adv at Start and add an
action cue of Pause at a Time Line value a couple clicks sooner than the end (e.g. as above, set the pause
at 598). For more examples, please download Videodemo1.zip.

 The up and down arrows are used to move the cue being edited up or down in the cue list. A
number can be entered directly and the current cue will move to that line. Be careful rearranging a cue list
with action cues as, for example, a Fade cue for cue #3 will not work if #3 becomes #2. The program is
designed to keep track of movements, but they should be checked.

https://www.baxeldata.com/Files/videodemo1.zip
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   The Speakers box allows selection of which speakers will play the
output as well as the sound card used to do it. The program will inspect and discover all available outputs
and put them in the dropdown box. The caption will indicate how many speakers the selected sound device
has available. Stereo input files can be sent to any pair of speakers. Front and Rear can be selected
together for a quadraphonic output. The Stereo/Mono switch changes the possible selections as shown. If
the sound source file has more than one track (e.g. 5.1 has 3), the Matrix selection will show this selection
screen:

 Here input channels can be sent to outputs as a matrix. As
illustrated here, the input channels are matched to their expected outputs. But clicking X's anywhere in the
grid will send channels to outputs as you wish. 

 Click the Loop box to continuously repeat a sound until some action is taken
against it. If the sound file is a playlist, the list will be looped. If the cue is an Action cue the program will
jump back to the cue number entered. A loop can be stopped by an Action cue, particularly a Wait for End,
whereby the program will finish the loop and move on. Auto Play will start the cue playing as soon as the
cue line is active, most likely from a Cue Advance. Auto Fade will start to fade the cue at the Fade at End
value before it would normally end. For example: if the cue is 13 seconds and the Fade at End value is 30,
the cue will start to fade at 10 seconds into the cue. All Fade durations are in tenths of a second. For
example, a value of 20 gives a 2 second fade.  The XFade checkbox can be used for both sound and video
cues. For video, it indicates the cue will cross fade from whatever is currently playing  in the video to the file
for this cue. For sound, since multiple files could be playing, the number in the Cue # field indicates which
cue should be faded out as this one fades in. The fade out time of that cue will be the same as the Fade
time of the cue being edited.

 Cue Advance will drop down to allow selection of No, at the End, at the Start, when a
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Fade is started, or (if a video cue) when video is paused, or when a file is loaded or rendered. It takes a
small amount of time to load and render a video file, so if the Master and Slave videos are to play in sync,
then they must be loaded first and then played with a separate cue(s). All of these Advances are available
so that the cue list can be designed to run simply going cue to cue.

 Cue Action is selectable for numbered sound file entries. If the sound file name is an
actual sound file, then Play is the only option and the drop-down is disabled. Otherwise, you may select
Pause, Resume, Fade Out, Stop, Wait for End, End Vamp, or Fade to Pause to affect the numbered cue.
Wait for End works for Independent cues only. End Vamp, also Independent only, lets a vamping cue
continue to the end of its file. Fade to Pause fades out the sound as in Fade Out, but rather than ending the
play, pauses the file so that it can be started again at the same place with a Resume cue. Play Loaded will
simultaneaously play all preloaded cues, sound or video. This allows two or more sound cues that have
different sound devices to be played with their outputs synchronised. Playing a video to both local video
players would also be in sync. 

Picking an F key  will set the cue to allow playing that cue whenever that F key is pressed. You
may also use the 'k' and 'l' keys that some key mapper programs employ.

 The Delete button at top will delete the cue, the same as on the Main screen. It is repeated as
it is difficult to delete an auto-play cue from Main.There are also buttons to test, stop and save the cue.
Save/Add allows adding a cue immediately after entering the previous. If a cue has corresponding action
cues, an alert will pop up suggesting to check them so that they stay in sync. Since there is error checking
at Exit, the top-right X to close the window is disabled.

There is a 5 band equalizer and a reverb to customize the output sound without having to go back to your
sound editor program to 'tweak' it.
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 For Sound cues, there is the option to set the tempo of playback. The speed of the file can
be adjusted plus or minus 25% without changing the pitch. Useful in dance performances to match the
choreography. 

 If the Cue type selected is 'Network Video' then this menu will appear instead of the Tempo
setting. It will indicate which of the four remote video players are connected by turning the dots green and
allow selection of which of them this cue applies to. Multiple ports can be selected so that a video command
could go out to any or all ports. That way one cue can fade everything, for example.

A video cue, both picture and movie will have this box at the bottom:

 This let's you set the size and position of the cue
on the projector screen. The Setup button will bring up this window where the corners of the image can be
set graphically. You can still enter the percentages directly if you wish, but what you drag the green dots to
here will be transferred as values to the percentages.



Cue Player Premium Help

20 / 33

   The Test button
will transfer the new settings to the projector image so you can see the effect.

 If Mask is unchecked then the size is adjusted to fit inside the outline. When Mask is checked, the image
covers the entire screen, but just the outlined area is visible. Here is an example of size vs. mask:

  

 Like Tempo for sound, Speed will will adjust the playback speed plus or minus 100%. Expect some
jerkiness in playback once you get down below 10%.

You may want a movie to end with the last frame displayed instead of fading to black. The 'Ends in ...'
buttons control that. A movie cue that ends in image would normally have a Fade cue following it to fade to
black when you want it.

Created with the Standard Edition of HelpNDoc: Free EBook and documentation generator

Video Cues

Video Cues - the "Plus" add-on Previous Top Next

It is recommended that downloading and inspecting the videodemo cue file will go a long way to explaining
the operation of the video add-on. You will also want to read the Edit screen topic for video cue playback
options. 

Some explanation on the video player is in order, however. The best way to use it is to have two video cards
in your show computer and set up Windows for a dual monitor display. You can set that up to have the Cue
Player control display on either the left or right and slide the video player over to the other. The little button

https://www.helpndoc.com
https://www.baxeldata.com/Files/viddemo1.zip
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with the monitor icon will put you in full screen mode. Even more, if you right click it while it is still on the
same screen as Cue Player (like at startup), it will move the player over and make it full screen in one click.
Which way it goes depends on which half, left or right, the window is when you click. The 'Resize to Last'
option will modify this behavior to moving the screen to the size and position it last was when closed. You
can also double click on the screen part to go full screen or not. A right click on the screen will bring up a
menu about hiding controls and such. When the controls are hidden, the screen position and size can be
fine-tuned using the arrow keys. Ctrl+Arrow will move the screen up/down/left/right per which arrow. Alt-
Arrow will resize the screen - down or right for larger, up or left for smaller.
 
Video cues have some additional information in them from sound cues. At the end of each cue is a series of
two or more numbers e.g. C;\video.mpg;0,150, or C:\video.avi;0,132,400. The numbers indicate where the
movie is to start and where it is to pause or stop. In the first example, the movie would start at 0 and stop at
150. In the second, the movie would start at 0, pause at 132 and if resumed, go on to 400 before stopping.
To loop a video, not only check the Loop box on the edit screen, but also set the end time to one or two less
than the actual end. e.g. C;\video.mpg;0,149

Unlike sound cues which can be buffered such that cue #3 with one sound can be immediately followed by
cue #4 with another and #4 can be selected waiting to be played, back-to-back video cues need a fade or
stop action cue between them. However, pictures and video can be cross-faded one after another. A series
of cross-fades must start as a normal cue. Cross fading is allowed beween picture to picture, picture to
video, and video to video.

The sound from video cues does not go through the same audio process as a regular sound cue. As a
result, the equalizer, reverb, and speaker settings of the cue are not in effect. Since almost all theatrical
videos are silent, this is not considered an issue. Should those features be needed, it is suggested to
extract the sound from the video and play it as an additional autostart cue after the video.
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Playwin Settings:
 Clicking the tool icon on the far right of the command bar will bring up a window to allow you to set:

      Timing - select either using timing information from the playing media itself of an internal timer. The
interval of the internal timer is set in milliseconds. Experience has shown that more repeatable timings
come from the internal timer.
     As Is - when displaying images (.bmp, .jpg,, .tif, .png, etc.) the displayed image is rendered at whatever
size it is, independent of the video player window size. Depending on the relative sizes, only part of the
image may appear.
     Stretch -  the displayed image is stretched to the size of the player corner to corner.
     4 by 3 - the aspect ratio of the image is held to 4 by 3, which is the old TV ratio.
     16 by 9 - the aspect ratio is held to 16 by 9, or 'widescreen'.
     Network -  The IP address of the computer running Cue Player must be entered so Playwin can find it. If
running on the same computer as Cue Player itself, it can be left blank or 127.0.0.1 should connect no
matter what the actual address is. Port number default is 5065 for the Main player and 5066 for the Slave. If
Remote from CP is unchecked, you do not need to do anything about address and ports. If you do not want
to click the connect icon every time, select AutoConnect. If the video player is running on a remote
computer not running Cue Player, then Remote from CP should be checked to enabled entering the remote
IP address and port. Remote computer ports start at 5900 and increment by one for each running instance
up to 4. You can edit the cueplayer.ini file values for NetPort and/or NetVideo to change them if needed.
     Audio Output - The audio output device may be selected with the same options as the main cue edit
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screen. It applies to all video cues.
     Play Delay - there was an issue (since been corrected) with a brief flash of a prior paused video cue upon
display of the next. The fade in of a cue was delayed by the amount of this setting to avoid that. It can still
be used to 'tweak' sychronization of two computers.
    Resize to Last - when the screen icon toolbar button is right clicked, the screen will resize and position
to what and where it was when shut down. A left toolbar click ignores this setting and the screen will expand
to fullscreen.
    Send Exceptions - any problems with rendering or display will be sent to the computer running Cue
Player.
   Background Darkness - a level between 10 and -10 of the background 'black' level. -10 is blackest. You
may want to set this to match the black level of your projector to make image edges blend in.
   Vignette Level - the edges of a playing video can be softened to make it blend better with the projection
surface.
   Cameras - drop-down selection of any installed cameras for display as cue file name 'Live'.

Right Click menu:

  Right clicking in the blue background of the player will bring up a menu of the
running controls and appearance options. Full Screen and Hide Controls are toggles for those two options.
Corner pinning is done by moving the red corner dots to a position on the blue background. Use them to
correct the image for keystoning or an angled projection surface. Hiding the markers will save the postions.
When more than one monitor is setup in Windows, the option to quickly move and make fullscreen to either
additional monitor is enabled. If the player has been sized already to a projection surface and closed, that
size and position can be restored with a click.

Here is an example of using the red corner pins to create some horizontal keystoning. The blue is the setup
screen and the test pattern shows the resulting image.
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Remote Networked Video -

First step would be to copy playwin.exe, playwin.ini, and dot.png from your main Cue Player install to a
directory on the networked computer. Also copy the LibAV64 (or LibAV32) directory and its contents to the
same place. Second, the video files must be the same, and in the same place on both computers. That is, if
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sunset.jpg is in the C:/shows/thisshow/pictures directory on your main computer, sunset.jpg wants to be in
the c:/shows/thisshow/pictures directory of the remote computer.

Look at the Help > About screen on Cue Player and note the IP address of your main computer. Go to the
remote computer and start playwin.exe. Click on the Settings icon (hammer and screwdriver) and look in the
Network panel. Enter the IP address of the main computer and the port number 5900 (default). Check both
boxes AutoConnect and Remote from CP. Position the video window as you would if running at the main
computer.

Come back to your main computer and the show cue list. Add a cue and make it a Network Video cue.
You'll notice the lower right panel changes to allow you to pick the network connection. If the remote playwin
on port 5900 is running, the first dot should be green. Click the Port #1 selection to send the command to
play the file listed in 'Video file name' (e.g. C:/shows/thisshow/pictures/sunset.jpg) to the remote computer.
Should you have more than one remote computer, you could send the command to more than one computer
with the same cue.

-----
Just a general note – playing videos is not easy for computers. While the sound playback will work well with
a entry level laptop, using it to also play a movie may result in stuttering and hangups. For serious video
playback, a desktop computer with a plug-in video card is recommended.
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MIDI Control
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Starting with version 3.7.3, Cue Player has the ability to be controlled by MIDI signals. These can come
from light board consoles or microphone control programs like Palladium. Cue Player works in what is called
"non-linear" mode, where cues are selected as they are played.
The MIDI commands are as follows, where n is the MIDI small device number and TT is the track or cue line
number from Cue Player:

            Emergency Stop - Bn.7B.00
            Play - 9n.TT.00
            Pause - 8n.TT.00
            GoTo - Cn.TT
            Stop - 8n.TT.01

Here is a screen shot of the Palladium setup:

Use the "Set MIDI Input Port" Options menu selection to set the port. You will need to edit the cueplayer.ini
file if you need to change the channel number (device 1) from 0.

https://www.helpndoc.com/create-epub-ebooks
http://www.chsounddesign.com
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MIDI commands to be sent have the format "xn.xx.xx" with values per your end device.

The program LloopBeMon may be useful if running a control program and Cue Player on the same
computer. It virtualizes a MIDI connection.

Created with the Standard Edition of HelpNDoc: Generate Kindle eBooks with ease

OSC Control

OSC Control Previous Top Next

Cue Player has the ability to be controlled by and originate OSC signals. These can come from / go to light
board or audio mixer consoles over the local network.

The network parameters are described in the "Set Cue Add defaults" section of "Options Menu". You will
need to know the IP address of the device you are sending to and the port number it is listening for. For
messages coming into Cue Player, they need to come in on the Listen Port. Although any port number may
be used, please check your firewall for port numbers that may be blocked.

Valid commands Cue Player will respond to are: "play xx", "goto xx", "pause", "resume", "stop", and "fade",
where xx is the cue number you want to play or goto. The Function keys can also be simulated when "fx" is
received.

Sending an OSC message is done by selecting the cue type "OSC Command" and putting the command
text in the field where the sound file name would normally go. Remember, all OSC commands start with a '/'.

The commands for Mixer Mute & Control mute cues have the internal syntax of "/ch/xx/mix/on ,i y" where
xx is the channel number, 01 to 32 and y is either 0 or 1. That is the Behringer X32 format and may apply to
other mixer brands as well. Please contact Baxel Data if you find it works on your mixer, thank you.
To activate a mixer channel, enter its number where you would normally have the sound file location.
Numbers are separated by commas and a range is indicated by a dash. e.g. "1,3,7,10-15,23".

To use other mixer control commands, enter each separated by a semi-colon. e.g. "/ch/xx/mix/fader ,f
.5; /auxin/yy/mix/fader ,f .6". Any command with either ,f or ,i in it needs to be sent as a Mixer Mute.

To synchronize 2 instances of Cue Player running on Main and Backup computers, use the "OSC Setup for
..." area of the Main computer to enter the IP address of the Backup and set the Listen port on the Backup
to the Send port of the Main. If "Send Play button" is enabled, playing cues on the Main will be kept in step
on the Backup so a changeover can happen immediately.

Cue Player can be integrated with the popular program 'X32 Theatre Control' to allow it to trigger Cue Player
cues. Please look at the X32 TC manual under 'Playback Cue Control' and 'Show Setup > Playback...' for
details on how to implement.

You can download an OSC test program from the web site. It will allow you to test with other OSC enabled
devices.

Created with the Standard Edition of HelpNDoc: Easily create Web Help sites

DMX Control

After Cue Player is running, a DMX interface can be selected to be used in a cue. The selection is done
from the Options > Set Defaults menu:

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
http://www.baxeldata.com/Files/OSCDemo.zip
https://www.helpndoc.com/feature-tour
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There is a choice of interface types - USB or ArtNet. Compatible interfaces are the same as for Cue Player
Lighting and are an easy search on the Web. Please do not try to use the less expensive 'Open' versions of
some vendors, but use one that has an internal processor and is "Enttec compatible". Both Enttec and DMX
King make reliable devices. For USB, having the device plugged in and clicking the selector should show the
interface model name in the 'Interface' field. If it doesn't, then you are not connected. Clicking the ArtNet
selector and then the 'Poll' button should show the IP addresses of any ArtNet interfaces on your network in
the drop-down box. Select one and it will go into the Interface field and be used for cues.

Cue syntax on the edit screen is channel @ level, or xxx@yyy, 22@125. Channels are for one universe , 1
to 512 and levels from 0 to 255. Closing the program will send 0 to all channels. Multiple commands can be
separated by a semicolon, eg. 12@100;123@255.

A special use of the DMX cue type is to start, pause, and hide the production timer. The timer is channel 0
and a level of 0 hides the timer and displays the clock. A level of 127 toggles the timer running. Level 255
will start the timer and display it. This cue will start the timer:

 
And this cue will stop it:

 The additional 0@0 command switches the display back to the
clock. Use the pop-up menu to go back to the timer if needed or don't have it at all to leave the timer
showing. A DMX interface does not need to be installed to use the timer.
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Remote Control

An on-going problem for many is how to have a presenter be in control of his/her slides and movies when
using the theater's projection system. Cue Player has addressed this issue with a web page based remote
control interface. Any device a presenter has, be it phone, pad, or tablet that can bring up a browser can be
used as a remote control for a Cue Player cue list. The same need may hold true for rehearsals where the
Director or Stage Manager wants to run cues and not have to be "in the booth" to do it.

There is a selection on the Options menu for 'Enable Web Remote'. When checked, the remote control
server is launched and minimzes itself in the lower left corner of the screen. You do not normally have any
interaction with it. To use it, open a browser on the presenter's device and enter the local net address of Cue

https://www.helpndoc.com/feature-tour
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Player followed by ":8880". The address can be found on the Help > About screen of Cue Player. It would
normally be something like 192.168.0.xx. For example, if xx is 25, then the web address for remote control
is 192.168.0.25:8880. If there is a port conflict with 8880, then it can be changed by editing the
CPPremote.ini file. The result would be this:
                         Presentation Sample sound cues
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The top is a scrollable list of the entire presentation. The descriptions are the same as appear on the host
Cue Player computer's window. Any row can be tapped to be selected. Touching Play would then display
the slide on Cue Player's video window or play the sound cue. The Next button moves forward to the next
slide or sound. If one of the lines is a movie or long sound, the Pause button will interrupt the playback and
enable the forward and back arrows. Pressing an arrow will move the playing position forward or back by 10
seconds for each press. Press Resume to continue the cue from that point. The small scrollable window at
the bottom displays the communication messages going back and forth.

There is a training video on the web site that documents the entire process from creating a Power Point
presentation to using this remote control feature at your site.

Created with the Standard Edition of HelpNDoc: Write EPub books for the iPad
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Stream Deck

Stage Manager view

 
Closeup

StreamDeck is a third party button interface that can be programmed to generate keyboard signals, macros,
a great variety of outputs. We use it to emulate the key commands of Play, Fade All, Stop All, and the Up
and Down keys. The Cue Player profile for it will also show the current cue number or cue call that will be
played when the Play button is pushed.

To use the StreamDeck, obviously the first step is to buy one. Their web site link (shown above) may
redirect you to Amazon where the 6 button Mini is $79. Next, install the StreamDeck software. The link to it
is also on their web site. We tried to install it on our D: drive and it didn't work. Go with the suggested drive
and directory the installer gives.

You will also need to download and install the text file tools from BarRaider. Once you have that file, install
is a simple double click. To install the Cue Player profile, double click on the CuePlayer.streamDeckProfile
file you'll find in the Cue Player installed directory.

If you open the StreamDeck application, you'll see this screen:

https://www.elgato.com/en/stream-deck-mini
https://github.com/BarRaider/streamdeck-textfiletools
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Click on the "Cue 19" button and the screen will add this:

The "File Name:" should point to the SDbutton.txt file in the Cue Player installed directory. If you installed
Cue Player somewhere other than the default, you'll need to correct this.

Note that the StreamDeck tool will allow you to drag and drop the buttons to a different layout. If you want
Fade next to Play, click and drag the Fade button until it's over Stop and release. The buttons will flip.

The Cue Player Options menu's last line is "Enable Stream Deck". Selecting that will popup a submenu:

  You may choose to show either the Row number of the cue list or the cue call
preface of the cue line. As you use Cue Player and move through the cue list, the button will show the cue
that will be played when the Play button is pushed.

The addition of Stream Deck has no effect on what was normal operation. That is, the Space bar will still
play cues and the Cue Player screen buttons can still be clicked.
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Help Menu

Help Menu Previous Top Next

Help Topics - This file.

Registration - Displays the Registration information for this install.

Check for Update  - Assuming this computer has network connectivity, will go to the Baxel Data Systems
site and determine if a more recent version has been released from the one you are using. If so, it will offer
to download it.

About - Displays the version and copyright information. It also shows the IP address of the host computer
that you will need to enter on remote video players.
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How do I set up an audio cross fade? - A cross fade used to require 3 cues. The first cue would start or
fade in the first sound and should be set to 'Advance at Start'. The second cue was a 'Fade Out' action cue
to the first sound and also set to 'Advance at Start'. The final cue was the fade in of the second sound and
be set to 'Auto Play'. There is an example cue file on the web site for this. With the 64 bit version, there is
an 'Xfade' checkbox and an edit box to enter a cue number to fade out. This only requires the two cues.

I bought the program a while ago, got my registration key, and now I want to test out some videos, but it won't
let me? - Just send an email to support@baxeldata.com and explain the situation. A trial key will be sent to you.

There are other sounds happening as I click and use the program. -  It is a good idea to set the sound
scheme to 'No Sounds' from the Control Panel to avoid extra sounds. 

I've got three sounds running all at once. I want to pause them all at once, then start them all up again later? -
This requires several cue lines. Let's say the playing cues are #3, #5, and #6. Action cues should be added for
each of those to Pause them. Set Advance to be at start and select Auto Play for all but the first. To resume them
playing, add another 3 cues with the action to resume in a similar fashion.

I need a simple sound file editor so I can trim and customize my sounds. Suggestions? - Audacity is a very good
free editor. For simple start/stop settings, that can now be done on the edit screen.

I'm having trouble getting videos to play or when they do it takes 100% of the CPU. - The video
render mechanism has recently been changed to address this. Please go to the web site to ensure you
have the latest release. If necessary, QMC (Quick Media Converter) is useful to change a video clip's format
should your computer have trouble rendering one format or another.

I want a stereo sound to just go to the Rear speakers, but it still comes out of all of them. - This is
likely caused by your sound card settings. Sound cards will often install a control program that allows you to
simulate 'surround' sound from stereo sources. That must be disabled to get sound only out of the Cue
Player selected speaker set.

What's the best way to save my files between the theatre and home? - The best way seems to be to
have the same directory structure on both computers and to keep all the files, cue and sound, in one
directory per show. Something like c:/shows/thisshow, c:/shows/thatshow, etc. That way you can copy the
whole directory to a thumb drive and be sure you've got everything. You might want to put your preshow
music in a subdirectory (e.g. c:/shows/thisshow/preshow) so you can use the "Create playlist from Folder"
menu option. You could also put your fire marshall/turn off phones speech up in c:/shows, since it is usually

https://www.helpauthoringsoftware.com
https://www.helpndoc.com
mailto://support@baxeldata.com
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common to all shows. The Backup/Save As menu selection can save the cuelist and files all together,
adjusting the cue list appropriately, as an option.

How do I run the program as a non-Administrator? - The program needs to be "Run as Administrator"
during the registration process. Once you have your registration key and have registered the program, you
may remove or rename the file "cueplayer.exe.manifest" in the installed directory.

I set a cue to AutoPlay and now I can't click on it to Edit or Delete. - Do a right-click on the cue line to open the
Edit screen. There is a Delete button on the Edit screen just for this reason.
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How To Buy

How To Buy Previous Top 

Credit card payments are accepted by Share-It.

Please go to Cue Player Premium to order.

You will receive your Registration key within 48 hours.
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